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The Park West Camera Club is an independent 
not-for-profit corporation. Guests are always 
welcome to our weekly Zoom meetings.

The PWCC newsletter, Photo Notes, is published 
every month by and for the members of the Park 
West Camera Club. Subscriptions are included 
with Club membership. Yearly subscriptions are 
available to non-members by email free of charge.

Submissions of full-length articles or smaller   
items of photographic or general interest are      
always accepted. The staff of Photo Notes              
reserves the right to edit any submissions       
which are published.

Photo Notes is optimized for viewing digitally.

Contact Information 

Website
www.parkwestcameraclub.org

Email Addresses
General  pwccny@gmail.com

Photo Notes  pwccny@aol.com

Club Mailing Address
PWCC

680 West End Avenue, #5D
NY, NY 10025 

Club Officers 

President Chuck Pine

V. President Michael Schleiff

Corres. Sec. Helen Bohmart Pine      

Rec. Sec. Christine Doyle       

Treasurer Joe Nawy

At-Large Betsy Currier
Jeff Langford

Committee Chairs 

Competition Hedy Klein

Field Trip Jay Bitkower
Ann Broder

Membership Marlene Schonbrun

Photo Notes Chuck Pine

Print Salon Betsy Currier

Program Marilyn Fish-Glynn
Alice Somma

Social Vacancy

Website Michael Schleiff
 Christine Doyle        

Workshop Ed Lee
Bruce Byers

Currently Inactive Committees 
Archive
Gallery
House

Cover Photo 
Immature Little Blue Heron 

© Chuck Pine

http://www.parkwestcameraclub.org
mailto:pwccny@gmail.com
mailto:pwccny@aol.com
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President’s Message 

“The time has come,” the Walrus  
   said,
“To talk of many things:
Of shoes—and ships—and 
   sealing-wax—
Of cabbages—and kings—
And why the sea is boiling hot—
And whether pigs have wings.”

At a recent Club meeting—on 
the night we had a workshop 
cancellation—in addition to  
having an impromptu PDI 
review workshop (see page 36) 
we discussed several things of 
importance to Park West 
members. Here’s a recap…

Topic #1—AI and Competitions
Artificial intelligence in photo-
editing software is just about 
everywhere. Generative this, 
content aware that—it’s 
ubiquitous. You can’t “not” use 
it when working on an image. 
The question is, “How much 
should we allow to be used in 
our Club competitions?” 

Currently, our By-Laws and 
Competition Manual state that 
your images must be your 
work. In other words, the 
pixels in your image must 
have been captured by your 
camera. You can combine 
images , if you shot both (or 
all) of them. You can use 
software to expand an image 
because the program is 
duplicating your pixels. You 
can use software to expand an 
image because the program is 

filling in the now-empty areas 
by duplicating surrounding 
pixels. And so on…

What you cannot do is use 
prompts to tell the software 
what to do. Examples of this 
would be: “add a dog in the 
foreground;” or “change the 
image to look like a Picasso 
painting;” or… you get the 
picture. (Sorry for the pun.) 

Your comments are always 
welcome.

Topic #2—Image Appearance
Some people complained that 
their images didn’t look as 
bright, nor the colors as 
vibrant, when watching the 
monthly competition as 
compared to how they looked 
when they made them. When 
some members compared their 
original .jpg image (as sent to 
the Club’s competition email 
and then forwarded by Hedy) 
to the images that appeared in 
both Photo Notes (produced by 
Chuck) or the slide show of the 
competition (prepared by 
Marlene), they were correct. 
There is a difference.

     [continued on next page]
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President’s Message 

[continued fro7m previous page] 

We tested it on our own 
computers. And, yes, there is a 
difference. We wondered why. 

The conclusion we arrived 
at is simple. During the 
competition program we show 
the actual .jpg images using 
Adobe’s Bridge software. 
(Bridge is the part of Photo-
shop that stores, sorts, and 
shares images—exactly like 
Lightroom’s Library and 
Slideshow modules do.) The 
images in Photo Notes and the 
competition slideshow are 
not .jpgs—they are converted 
to .pdf files and then reduced 
in size so they can be emailed. 
This process affects the 
appearance of the images.

What can be done about it? 
After hours of research,… not 
much! If you want your 
images to look brighter and/or 
more vibrant in competitions, 
you can try increasing the 
brightness and the saturation 
of them during your post-
processing workflow. If you do 
this, however, be gentle with 
the sliders—a little bit goes a 
long way.

Another problem has to do 
with monitors—especially if 
they are not regularly 
calibrated. Every device that 
displays images has its own 
idiosyncrasies. Colors are 
different, contrast is different, 

in fact, anything that can be 
adjusted could be different. 

Here’s something for you to 
try. Go to a store that sells TVs. 
Costco, P.C Richards, Best Buy 
or any other will do. They 
usually have dozens of sets 
tuned to the same channel. 
Compare what you see. 
They’re all different. Why? 
Because they’re not calibrated! 

Topic #3—Themed Competitions
A discussion was held about 
why are we having themed 
competitions this year. The 
point was made that all of our 
competitions should be open, 
themeless, and nonrestrictive. 
Members should be able to 
express their opinions through 
their images. The themes 
curtail the photographer’s 
ability to tell their own stories.

So, why did we schedule 
two themed contests this year
—the Color Blue and Portals? 
The idea of themes was 
mentioned by many of our 
members in the questionnaire 
we sent to the membership last 
summer. It was further 
discussed at our September 
business meeting. If I recall 

correctly, themes were decided 
upon without any opposition.

It was further pointed out 
that we will have another 
discussion about the themed 
competitions at the May 
business meeting. Members 
will be able to decide whether 
we want to have any next year, 
how many, and possibly even 
what the themes will be.

If you have anything you’d 
like to add to any of these three 
topics, I’d be glad to discuss it 
with you at a future business 
meeting, via email, or 
whatever. 

Both Punxsutawney Phil and 
Staten Island’s Charles G. 
Hogg saw their shadows this 
year. This means another six 
weeks of winter. Great for 
shooting snow scenes, bundled 
up people, and kids on sleds.

Enjoy, and keep warm,

C
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Chuck

Blue Tang 
© Chuck Pine
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Sep
  1 No Meeting—Labor Day
  8 Welcome Back *
15 Guest Speaker
22 No Meeting—Rosh Hashanah
25 PDI Workshop *
29 Business Meeting #1

Oct
  6 Competition #1 *
13 Workshop—Composition *
20 Guest Speaker
23 PDI Workshop *
27 Theme—Halloween & Fall *

Nov
  3 Competition #2 *
10 Mini Portfolio Night *
17 Guest Speaker
20 PDI Workshop *
24 Business Meeting #2

Dec
  1 Competition #3 *
  8 Workshop—Motion & Multiples
15 Holiday Party 
22 No Meeting—Holiday Break
29 No Meeting—Holiday Break

Jan
  5 Competition #4 *
12 You Be the Judge—Bridges *
19 Guest Speaker/MLK Day
22 PDI Workshop *
26 Vendor Night

Feb
  2 Themed Competition #5* (Blue)
  9 Before & After *
16 Guest Speaker/President Day
23 Interpretations *
26 PDI Workshop *

Mar
  2 Competition #6 *
  9 Workshop—Manipulation
16 Guest Speaker
23 Theme Night—Motion & Multiples *
26 PDI Workshop *
30 Business Meeting #3

Apr
  6 Themed Competition #7 * (Portals)
13 Before & After—Color/B&W *
20 Guest Speaker
23 PDI Workshop *
27 You Be the Judge—At the Museum *

May
  4 Competition #8 *
11 Guest Speaker
14 ExpVis 32—Intro
18 Business Meeting #4
25 No Meeting—Memorial Day
28 ExpVis 32—Assignment #1

Jun
  1 Year End Competition *
  4 ExpVis 32—Assignment #2
  8 Otto Litzel Memorial Dinner
11 ExpVis 32—Assignment #3
15 ExCom Meeting
18 ExpVis 32—Assignment #4
22 Year-Long Project
25 ExpVis 32—Term Project
29 No Meeting 

For full details see “Schedule of Activities” 
at the end of this issue of Photo Notes.

All Club Monday night meetings will be 
held using Zoom software unless otherwise 
stated in the “Schedule of Activities.”

       * indicates members’ images requested
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Member Bios


New Park West Camera Club 
members are invited to submit 
a short biography to help the 
rest of us to get to know you 
better. The Club’s Membership 
Committee will be glad to help 
you with this task. 

We also would like to ask 
our not-so-new Park West 
members to do the same. Tell 
us about yourself, what you 
like to shoot, your background 
and history in photography, 
and whatever you think would 
be of interest your fellow Club 
members and friends.

Please send us a photo of 
yourself and three or four of 
your favorite images to go 
with the mini bio. Send your 
submissions to Photo Notes at 
<pwccny@aol.com>

C
LU

B Portfolios Wanted 

Photo Notes, your monthly 
Park West Camera Club 
newsletter, is looking for 
portfolios of members’ work. 
Newly shot work—of course! 
Old  images from your 
archives—why not? Anything 
else you’d like to share—fine!

Please submit anywhere 
from a half dozen to ten files 
on a concise theme. 

Images must be processed 
as if they were to be entered 
into a competition. [See page 7 
for instructions on resolution,  
sizing, format. etc.] Include a 
short write-up (who, what, 
where, when) with each and 
every submission—spelling, 
grammar, and the rest don’t 
count. We edit your words, 
not your images.

Even if you’ve submitted 
work in the past, we always 
want to see new and creative 
photography.

Avoid these Mistakes 

There are many mistakes you 
make that lead to the creation 
some not-so good images. 

Spread throughout this issue 
of Photo Notes are some of 
these errors in our workflow.

Which ones do you make? 
Are you willing and able to 
eliminate them

Read, learn, and enjoy… 

Official Club Field Trips 

The Club has brought back 
field trips to our program. 
I’m not referring to the Pop-
Up trips we’ve been having.

Official PWCC outings 
are back on the schedule. 
Several have already taken 
place—and with a great 
deal of success, I might add.

If you’re interested in 
organizing and leading a 
field trip, contact Chuck 
with your ideas and we’ll 
work with you to set it up.

mailto:pwccny@aol.com
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Zooming 

Zoom is a web-based video- 
conferencing software tool 
that allows users to meet   
online. Zoom is compatible 
with Macs, Windows, smart-
phones, and tablets. Zoom 
software is free to download 
to your devices.

The Club is using Zoom 
software to conduct all of its 
meetings. An email will be 
sent to all PWCC members 
prior to meetings. This email 
will contain the link to join 
the Zoom meeting. All you 
have to do is click on the link. 

To download Zoom, go to 
<www.zoom.us/download> 
and click on the “Download” 
button. It’s that simple!

Non-members who 
would like to join our Club 
meetings may request the 
link by sending an email to 
<pwccny@gmail.com> 

Pop-Up Trips 

The Club instituted Pop-Up 
field trips several years ago. 
Just what is a Pop-Up (also 
called a Drop-In) trip, I hear 
you cry? It is a field trip that 
any one of our Club members 
wishes to go on without a lot 
of pre-planning and fanfare.

You decide where you want 
to go and when you want to go 
there. You send a message via 
our Google Groups to all the 
other PWCCers who have 
signed up. It’s that easy!

Whoever shows up will be 
a surprise. All you’ve got to  
do is shoot away and have   
fun doing it.

As an afterthought, it 
would be appreciated if all 
those who attend send a few 
images from the trip for Photo 
Notes. A short article would be 
nice but isn’t necessary.

C
LU

B Submitting Images 

The Club has over a dozen 
activities this year which ask 
you to submit images. These 
include competitions, theme 
nights, workshops, classes, 
and more. Here’s what you 
need to know:

Images must be .jpg, with a 
resolution of  72 ppi, 2,000px 
on the longest side, and max-
imum size of 2MB.

Competition images must 
be titled as follows:

LastNameFirstInitial_Month 
Year_Title.jpg

for example

JonesM_Jan26_Flower.jpg

Other images should be  
titled as follows:

Name_Number_Title

You may use your first and/
or last name/initial. If you 
want your images shown in   
a particular order, number 
them 01, 02, etc. Use a real  
title, not the image number 
that came out of the camera.

for example

MaryJ_07_Flower

Emailing PWCC

Send your competition images to…
<pwcccompetition@yahoo.com>

Send your articles, images, etc. for Photo Notes to…
<pwccny@aol.com>

Send all other email to…
<pwccny@gmail.com>

To contact Executive Committee members directly see the 
PWCC membership list for their personal email addresses.

mailto:pwcccompetition@yahoo.com
mailto:pwccny@aol.com
mailto:pwccny@gmail.com
http://www.zoom.us/download
mailto:pwccny@gmail.com
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Sunshine Fund

A motion was passed at a 
Club business meeting to   
establish a Sunshine Fund as 
part of the Social Committee. 
The responsibilities of this 
new entity are to acknowl-
edge birthdays, deaths, 
births, illnesses, and any  
other life events that impact 
our Club members and their 
families.

Long-time Club member 
Natalie Manzino has volun-

teered to take on this task for 
the Club. She has already 
purchased the necessary sta-
tionery to be able to express 
the sentiments of the Club 
and its members. 

But Natalie needs your 
help in achieving the Club’s 
goals through this committee. 
It would be great if each and 
every member could give her 
the month and day of their 
birthday (no years, please).

In addition, if you could 
let Natalie know of any life 
events that occur to any of 
our members, you or some-
one else, both present and 
past members, that would be 
great, too. 

917-757-7086
<bklynnat@hotmail.com> 

Club Meeting Times

The Park West Camera Club’s 
Monday night meetings this 
year will all begin at 6:30 p.m. 

You may sign into the Zoom 
meetings 15 minutes earlier 
to participate in the the lively 
member conversations.

PWCC Image Deadlines 

Event Submission Deadline Event Date

Before and After Feb. 7th Feb. 9th

Interpretations Feb. 21st Feb. 23rd

Competition #6 Feb. 23rd Mar. 2nd

Motion & Multiples Mar. 21st Mar. 23rd

Competition #7 Mar. 30th Apr. 6th

Mistake to Avoid 

Overlooking Composition

One of the most significant 
mistakes is neglecting the 
basic rules of composition. 
The Rule of Thirds, leading 
lines, framing, negative 
space, and more are not just 
artistic whims; they are the 
backbone of captivating 
images. Beginners often 
focus solely on the subject, 
forgetting how placement 
and surrounding elements 
can transform a run-of-the-
mill photo into a great one.

mailto:bklynnat@hotmail.com
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Club Participation Nites 

This coming year there will be 
10 Monday night programs,
(not including our monthly 
competitions) that require Club 
members to participate. Here’s 
a quick rundown on these fun 
and  educational activities…

•  September 8th—Welcome 
Back  What’d you do over the 
summer months? Share up to 
10 images to tell your story. 
Entry deadline: September 6th.

•  October 13th—Chuck Pine 
will be presenting a program 
on Photographic Composition. 
He would like to use your   
images to demonstrate the 
techniques. Entry deadline: 
mid August.

•  October 27th—Theme Night: 
Halloween & Fall  There’s lots 
happening this time of year—
from colorful leaves to ghosts 
and goblins. Show us how you 
interpret this season. Limit of 
10 images, please. Entry dead-
line: October 25th.

•  November 10th—Mini Port-
folio Night  Five Club members 
will volunteer to share a small 
portfolio of images on a single 
theme. They will explain their 

concepts and then answer 
questions from the members. 
Participants will be selected in 
early October. Entry deadline: 
November 8th.

•  January 12th—You Be the 
Judge: Bridges  You may submit 
one image pertaining to the 
subject that has never been 
seen at any previous Club 
function. You may interpret the 
topic however you wish. Each 
entry will be commented on 
and scored by all participating 
Club members. Entry deadline:   
December 12th.

•  February 9th—Before and  
After  We are always asking 
other photographers, “How 
did you do that?” Tonight we 
will get the answers as Club 
members present their ‘Before 
and After’ images of the same 
shot,… and explain what they 
did and why they did it. Join 
us as we learn from each other. 
Entry deadline: February 7th.

•  February 23rd—Interpreta-
tions   The Club will provide 
the base images. The members 
will alter them in any way they 
see fit. Let your imagination 
and software skills be limitless.   
Entry deadline: February 21st.

•  March 23rd—Theme Night:  
Motion and Multiples Following 
our December 8th workshop 
by Jamie Konarski Davidson, 
we’ll look at images you’ve 
taken that depict subject or 
camera motion and multiple 
images of the same subject. 
You may submit up to 10     
images of either one, or both 
techniques. Entry deadline: 
March 21st.

•  April 13th—Before and After: 
Color to Black & White  For this 
assignment you will share one 
of your favorite fully processed 
color images and then how 
you turned it into a B&W   
masterpiece. Entry deadline: 
April 11th.

•  April 27th—You Be the Judge: 
At the Museum  You may enter 
one image from or about any 
museum as long as it has never 
been seen at any previous Club 
activity. Each entry will be 
commented on and scored by 
participating Club members. 
Entry deadline: March 27th.

C
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PDI Workshops
Our Projected Digital Image 
workshops are held monthly 
on Thursday evenings prior 
to competitions. Deadlines 
are the previous day.

Over and out!

Been there,

done that!

Come and gone!

Success!

Come and gone!
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Images of the Month 

February 2026

PDI-of-the-Month

Menorah by Helen Pine

Honors

Mandrill In Thought by Betsy Currier

Maroc Fisher Boats by Elayne Dix

Open Sky by Sonia Durante

Legs by Florence Forman

Baby Blue by Mike Iannuzzi

Red Legged Honeycreeper by Eliot Nierman

Deep In Thought by Chuck Pine

Looking Up Guggenheim by Laura Toledo

C
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B

This month’s winning images—the 
PDI-of-the-Month, the Honors images 
and the “A” images—are shown on 
the following 7 pages.

Cumulative Points 
(Through February 2026)

by Hedy Klein

Natalie Manzino 80
Sonia Durante      74
Florence Forman    74
Michael Iannuzzi 72
Chuck Pine 72
Jill Greiss 70
Laura Toledo 64
Paul Grebanier 58
Michael Schleiff 58
Dudley Slater 58
Raylie Dunkel   56
Alice Somma 56
Nicole Dosso 54
Charles Levin 54
Marlene Schonbrun 54
Peggy Winkelman 54
Albyn Davis 52
Hedy Klein 52
Renée Harper 50
David Miller 50
Ann Broder 48
Bruce Byers 48
Elayne Dix   48
Richard Gold 48
Allan Lauer 48
Puneet Sood 48
Evelyne Appel 46
Bill Apple 46

Jay Bitkower 46
Barry Fahrer 46
Alec Rill 46
Larry Sapadin 46
Janet Susin 46
Richard Borowsky 44
Elena Pierpont 44
Will Aimesbury 40
George Corbin 40
Betsy Currier 40
Julie Foehrenbach 40
Doris King 40
Larry Rubin 40
Madeleine Barbara 38
Dottie Mills 36
Julie Wosk 34
Christine Doyle 32
Jeff Langford 32
Eliot Nierman 30
Catharine Smith 30
Dov Bieber 28
Tom Quackenbush 28
John Benson 26
Helen Pine 16
Remy Deyglun 12
Carlton Johnson 10
Karen Corrigan 8
Ruth Yashpan 4

This month was our first themed 
competition of the year. All of the 
images included the color blue.
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Image of the Month 
Menorah 

© Helen Pine

Continued on next page…
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‘A’ with Honors 
Maroc Fisher Boats 

© Elayne Dix

Continued on next page…

‘A’ with Honors 
Mandrill In Thought 

© Betsy Currier

‘A’ with Honors 
Open Sky 

© Sonia Durante
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Continued on next page…

‘A’ with Honors 
Baby Blue 

© Mike Iannuzzi

‘A’ with Honors 
Red Legged Honeycreeper 

© Eliot Nierman

‘A’ with Honors 
Legs 

© Florence Forman
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Continued on next page…

‘A’ with Honors 
Looking Up Guggenheim 

© Laura Toledo

‘A’ with Honors 
Deep In Thought 

© Chuck Pine

Congratulations to the winners in this 
season’s fifth monthly competition. 
And a great big “thank you” to all those 
members who competed and attended.
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‘A’ 
Foggy Night 

© Richard Borowsky

C
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Continued on next page…

‘A’ 
Stairway 

© Natalie Manzino

‘A’ 
Blue Canopy 
© Doris King

‘A’ 
Grand Entrance 

© Hedy Klein

‘A’ 
I C Stars 

© Barry Fahrer
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‘A’ 
Walls 

© Mike Schleiff

C
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Continued on next page…

‘A’ 
Venice Boat 

© Natalie Manzino

‘A’ 
Twin Towers Memorial 

© Richard Gold

‘A’ 
Sleeping Dog 

© Marlene Schonbrun

‘A’ 
Maine Blue Fog 

© Jill Greiss



     February 2026 www.parkwestcameraclub.org 17

C
LU

B

‘A’ 
Silhouettes on the Beach 

© Chuck Pine

‘A’ 
White Necked Jacobin 

© Eliot Nierman

‘A’ 
A Drop of Water 

© Marlene Schonbrun

Thank you to this month’s judge, 
Nancy Ori, for her excellent 
comments, constructive criticism, 
and consistent scoring.

• 56 members have competed in  
   this year’s competitions.
• 49 in the February competition.
• 22 images this month received 
   a score of ‘A’ or above (22.7%),   
   48 got a score of ‘B’ (49.5%),   
   and 27 got a ‘C’ (27.8%)—all in 
   all, a standard “bell curve.”
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Our February Judge 

Our judge for the month of 
February was Nancy Ori.

Nancy obtained her BA 
degree in Fine Arts from 
Elmira College and her MS in 
Visual Communications from 
Pratt Institute. Nancy worked 
for 25 years for several 
pharmaceutical companies as 
their in-house photographer 
and manager of Video and 
Photography Services.

Since 2001, she has been the 
owner of New Jersey Media 
Center where she shoots food 
and other products, portraits, 
and fine art images. 

Nancy was taught by Ansel 
Adams and then worked for 
many years with Ansel Adams 
Workshop as a teaching 
assistant. She then started her 
own workshop company for 
photography and other media 
in Cape May, NJ.

She founded the New 
Jersey Photography Forum, 
which has become the largest, 
most recognized, group of fine 
art exhibiting photographers in 
the state.

C
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All images 
© Nancy Ori

https://www.njphotoforum.com/
https://www.njphotoforum.com/
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Y•E•P!

by Ann Broder,
Cristine Doyle, 

and Marlene Schonbrun

At the third YEP (Year-End 
Project) meeting on, January 
21st, participants shared 
images from their projects and 
discussed how their work was 
progressing. From what we 
heard, it seems that more than 
a few participants may be 
wondering: Has my initial 
excitement about YEP begun to 
fade? Has picking up my 
camera begun to feel like a 
chore? Am I looking for 
excuses not to get out there to 
make photos? We hear you! It's 
so easy to fall into the well of 
no motivation. Here are a few 
thoughts from your three 
amigos on the subject.

Ann… It’s a struggle when all 
you want to do is a bit of street 
photography, but staying 
warm out there is impossible 
on cold days. The camera is 
cold, your fingertips are cold, 
and the wind shakes the 
camera. So frustrating. Then 
you move indoors, warm up, 
and photograph the people 
indoors, but you’re wearing 
heavy clothing, carrying a 
backpack, camera bag, well, 
you get the picture, so you 
head home and wait til Spring. 

LOL!
On a serious note—leave 

your camera in plain sight 

with a fresh battery and a new 
card. It’s ready to go in case 
you get the urge to pick it up. 
Pick it up and take one photo 
of anything; maybe you'll be 
motivated to take more. Make 
a shooting plan for the next 
day and leave it where you 
will see it when you wake up 
in the morning.  

Christine… Besides fighting 
the urge to hibernate at this 
time of year, especially after 
last month’s blizzard and deep 
freeze, I keep going back and 
forth on what my project 
should convey. We all know it's 
dark, and the streets are mostly 
empty in the early morning, 
but are those already on the job 
or on their way the real focus 
of the story? That’s a perennial 
challenge for street shooters 
regardless of the weather. So, I 
guess the answer is, as Ann 
suggested, to get my camera, 
put one foot in front of the 
other, and start shooting. (And 
keep reminding myself, Spring 
is not far away!)  
 
Marlene… My two big words 
are distraction and procrasti-
nation. And you all probably 
know what that means for you, 
too. After the 2nd YEP 
meeting, boy, was I motivated. 
Made a list of people I wanted 
to contact and scheduled a 
shoot with one of them. And

you saw the fruits of my labor 
at the last meeting. This time, 
not so. I announced that I 
needed to make a list of 
questions so that the interview 
part wouldn’t meander all over 
the place. I have yet to do it. 
And I need to formulate 
questions before my next 
shoot. Maybe, since I’m 
writing this down for Photo 
Notes, it will motivate me to 
get past my distractions and 
procrastination phase.

Ann…Well, there you have it, 
three more opinions to add to 
all the others we heard at the 
last YEP meeting. I suppose 
we'll be hearing more of the 
same until the weather abates. 
Meanwhile, do keep your 
camera handy and ready to go. 
You never know when you'll 
feel like climbing out of the 
depths of that well.

Our next YEP meeting will 
happen on Wednesday, 
February 25th. Marlene will 
send an email with the sign-on 
link at 6:15, and the meeting 
will begin promptly at 6:30. 
Please send Ann, Marlene, and 
Christine 3-4 jpgs no later than 
February 18th, using competi-
tion sizes and labeling, NO 
titles necessary. If you want to 
show them in a particular 
order, label like this: 01, 02.
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Print Salon 
by Betsy Currier

The goal of the Park West 
Camera Club Print Salon is to 
stimulate the making and 
discussion of print images by 
Club members. Our meetings 
are held on the second Tuesday 
afternoon each month. The 
next meeting will be on 
February 10th, at 4:30 p.m. 

If you’d like to join us, 
contact me (Betsy Currier) at 
<edcurrier7@gmail.com> to 
reserve your spot and get the 
location of the meeting.

 

C
LU

B Soho Photo Thank You 

Back in November last year, 
Wayne Parsons gave a pre-
sentation to the Club of his 
images. (We enjoyed it!) So, 
apparently, did Wayne—he 
waived the honorarium we 
usually pay our speakers. 

The ExCom decided to 
make a donation to Soho 
Photo Gallery in Wayne’s 
name. (He is a member of 
the gallery and one of its 
former presidents.) 

We recently received the 
following letter from the 
SPG treasurer, George 
Grubb (a former Park West 
Camera Club member).

Dear Park West Camera Club,

We deeply appreciate the 
support you have given to the 
SohoPhoto Foundation. Your 
support enables the SohoPhoto 
Foundation to pursue its 
mission to support the work of 
artists representing our 
society's cultural diversity, to 
provide a space to explore the 
context in which their work is 
created, to sponsor outreach 
programs to nurture young 
talent, to support under-
represented artists with 
original voices with exhibition 
opportunities, and to provide 
the greater community with 
public events and educational 
opportunities which are often 
free or at modest cost. We 
appreciate the generosity you 
have shown our organization. 
We hope that we can continue 
to count on your support in the 
future.

Thank you,
George Grubb, Treasurer
SohoPhoto Foundation, Inc.

Smartphone Metadata 

Whenever you take a photo, 
your phone records details 
behind the scenes. This is 
called metadata. It includes:
• Shutter speed
• ISO (light sensitivity)
• Lens used
• Mode (HDR or Night)
• Time, location, and image 

orientation

Most phones hide this info 
by default, but it’s easy to 
access once you know 
where to look:
1. Open the photo app
2. Tap any photo
3. Swipe up on the image or 

tap the ⓘ button

mailto:edcurrier7@gmail.com
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Curtain Raisers 
by Helen Pine

Curtain raisers are short        
(no more than five minutes) 
photography programs (with  
a minimum of narration)    
presented by Club members 
prior to our guest speakers.

Here’s the schedule for the 
2025-2026 Club year…

October Marlene Schonbrun
November Elena Pierpont
December Evelyne Appel
January Jeffrey Langford
February Helen Pine
March George Corbin
April Dinorah Capota
May Natalie Manzino

Photo Notes Deadlines 

     Issue Deadline

September Aug 18th
October Oct 6th
November Nov 3rd
December Dec 1st
January Jan 5th
February Feb 2nd
March Mar 2nd
April Apr 6th
May May 4th
Summer Jun 1st

The sooner articles and 
items are submitted to Photo 
Notes, the quicker the editing 
and revision process can begin. 
Once all items are in place the 
draft copy of Photo Notes will 
be sent to the editors who will 
then have several days to edit 
and return their comments.

Upon completion, the Photo 
Notes issue will be sent to all 
members, friends of the Club, 
and to the Website Committee 
to be uploaded to our website 
<www.parkwestcameraclub.org>
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The Executive Committee 
(ExCom) has decided to  
continue for this coming 
year with the committee
liaison model to spread the 
responsibility among the  
entire Executive Committee.

Here’s how it’ll work: 
Each ExCom member will 
be assigned committees as   
a liaison. Each committee 
chair or co-chair will report 
to the ExCom through this 
liaison. In this manner, it is 
felt that communication will 
flow much more smoothly, 
in both directions, between 
the committees. In addition, 
any concerns raised by the 
ExCom will be passed along 
to the committee chairs 
through the liaisons.

Here are the committee      
liaison assignments for the 
2025-2026 Club year…

Competition Michael
Field Trip Chuck
Gallery Helen
Membership Helen
Photo Notes Chuck
Print Salon Betsy
Program Christine
Website Michael
Workshop Joe

Inactive Committees
Archive
House
Social

February Birthdays 
by Natalie Manzino

Here’s the list of the Club 
members who celebrate their 
birthday during this month:

Elayne Dix
Barry Fahrer

Julie Foehrenbach
Puneet Sood

Marilyn Thypin

http://www.parkwestcameraclub.org
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PSA Membership 

The Club is a member of PSA, 
the Photographic Society of 
America. Are you?

Individual Member Benefits
• Online Photography Classes
• Webinars
• Individual Competitions
• Travel Advisors
• Monthly PSA Journal
• Study Groups
• Personal Gallery Page
• Individual Competitions
• Member Discounts (photo 

hosting and sharing; camera 
and lighting equipment; fine 
art master class; KelbyOne; 
software offerings 

     by Julie Foehrenbach   

Instagram, a social media site 
that focuses on pictures more 
than words, is a natural venue 
for a camera club. Park West 
launched its own Instagram 
page over three years ago and 
as of last month, we had 889 
postings and 558 followers. 
Impressive! The goal is to 
showcase our work and attract 
new members to the Club.

We only post images that 
have received an A or higher in 
our monthly competitions and 
whose creators give us their 
permission to post. To protect 
our work, we have employed 
settings that prevent others 
from stealing our images or 
profiles as their own.

If you want to create your 
own personal page, keep in 
mind that Instagram is 
primarily a mobile app—it’s 
designed to be used with a 
smartphone or a tablet. If you 
use a computer, you can look 
at the pages (“feeds”) but you 
won’t be able to post a thing.  
To visit the Park West page, 
download the Instagram app 
on your phone or iPad or go to 
<www.instagram.com> on 
your computer. Search for 
@Parkwestcameraclub and once 
you have found the site, press 
the FOLLOW button.    
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B On the Website 
by Michael Schleiff

The Club has set up forums for 
all members to use. The topics—
which you join or create—could 
cover any area of photography 
and imaging including, but not 
limited to, how-tos, gear, Photo- 
shop, Lightroom, plug-ins, and 
more. 

To get access to a forum,  
you must be signed in to the 
Club website with an active 
email address. After logging in, 
go to PWCC Members Discussion 
Forums on the dropdown menu 
and click to enter. As you scroll 
down you’ll see a basic explana-
tion of how these forums work, 
along with a how-to video. At 
the bottom of the page, there 
will be a heading for Park West 
Camera Club, with a button,  
View Topic. 

Once selected you will see 
the topics that have been set   
up along with a button to Create 
New Topic. You can view the  
topics and all the posts. You 
may even post a comment of 
your own.

All signed-up members will 
receive an email notice when 
new posts have been added. 
(You can easily opt out from any 
of the forums.)

Any questions, regarding  
the forums, contact me at my 
personal email address 
<mrscheliff@gmail.com>

Thank you and enjoy the 
PWCC forums.

Mistake to Avoid 

Not Using Camera Settings

Auto mode is a safe haven for 
beginners, but it severely 
limits creative potential. Not 
learning how shutter speed, 
aperture, and ISO work 
together leads to missed 
opportunities in capturing 
images as envisioned. The 
fear of manual mode can be 
overcome with practice and 
experimentation.

http://www.instagram.com
mailto:mrscheliff@gmail.com
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Gallery News & Thoughts  
by Ann Broder,

Jay Bitkower, 
and Julie Wosk 

The Gallery committee is back! 
Look for our column every 

month for news about upcom-
ing photography shows, gath-
ering ideas for future PWCC 
exhibits, and more. The lineup 
of discussions will cover topics 
such as curating exhibits and 
personal gains from participat-
ing in a gallery show. These are 
but a few of the topics in our 
gallery news lineup! Take note, 
this is the place for everything 
that is gallery!

Participating in an exhibit 
helps you show your work on 
a larger scale by inviting the 
public to share the experience.  
It motivates you to complete a 
body of work. It encourages 
peer feedback and improves 
artistic and technical skills.  
We’re looking forward to hav-
ing you join us on the ultimate 
journey for work well done!
 The Gallery Committee is 

actively hunting out possible 

venues for a year-end exhibit 
of work by PWCC members. 
We welcome suggestions from 
the Club. Venues may include, 
for example, gallery spaces, 
libraries, public buildings, 
schools or universities, uncon-
ventional spaces, or any large 
exhibit spaces you think might 
work. If you have suggestions, 
please contact any of the com-
mittee members. 

The nascent Gallery Com-
mittee plans to revitalize the 
old Gallery Hop, which ran 
gallery tours a few years ago 
for PWCC'ers seeking expo-
sure to photographers exhibit-
ing their work. As the photog-
raphers are unlikely to be in 
the gallery when we visit, we 
will provide our members with 
a short bio and a description of 
the type of photography they 
will see. We will include other 
venues, such as the Met, 
MOMA, and ICP. If available, 
we will also provide comments 
on shows reviewed in the 
press and possibly share our 
own reviews.
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by Jay Bitkower

I ran across an exhibit at the 
Howard Greenberg Gallery of 
The Texas Prison Photos by 
Danny Lyon, taken in the late 
1960s. Lyon began his photo-
journalism career in the Civil 
Rights era, being SNCC's first 
official photographer and 
having befriended and roomed 
with John Lewis.  

You can see his biography on 
the gallery’s website together 
with two of his prison photos— 
remarkably, he had unrestricted 
access to 14 Texas prisons. At 
the age of 82, he's still taking 
photographs, see <https://
www.howardgreenberg.com/
exhibitions/danny-lyon> 

Unfortunately, the show 
ended on Saturday, January 
31st. However, there’s a 
secondary link to all the Prison 
photos in the above link (if it’s 
still on the website).

https://www.howardgreenberg.com/exhibitions/danny-lyon
https://www.howardgreenberg.com/exhibitions/danny-lyon
https://www.howardgreenberg.com/exhibitions/danny-lyon
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You Be the Judge 11 

Bridges

The Club held its 11th iteration 
of You Be the Judge on January 
12th. The theme was “Bridges.”
There were 39 images in the 
competition, each of which had 
never been shown to the Club 
in any of our previous compe-
titions, theme nights or any 
other activities.

Each of the images was 
scored from 1 to 7 points by 44 
Park West members. The 
scores were totaled and the 
winner and runners-up were 
declared and shared with the 
entire membership.

The scores could range 
from 44 points (if all members 
rated the image a 1) up to 308 
points (if every member gave 
the image a 7). In actuality, the 
image scores ranged from 160 
to 267 points.

When converted to our 
usual monthly scores…  
• 8 images scored between 

220 points and 240 points 
and received an “A”

• 5 images scored between 
240 points and 265 points 
and got an “A with Honors”

• 1 image scored 267 point 
and was named “Image of 
the Night”
Here are the 14 winning 

images, the photographers 
who shot them, and their      
total scores…
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Image of the Night 
Ben Franklin Bridge 

© Ann Broder 
267 points

The other winning Bridge images—
the “A with Honors” images and 
the “A” images—are shown on the 
following 5 pages.
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‘A’ with Honors 
Ravenal Bridge 
© Helen Pine 

265 points

‘A’ with Honors 
Winter Crossing 
© Richard Gold 

251 points
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‘A’ with Honors 
Wedding Bridge 

© Natalie Manzino 
243 points

‘A’ with Honors 
Brooklyn Bridge 

© Dottie Mills 
249 points
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‘A’ with Honors 
Mario Cuomo Bridge 

© Jill Greiss 
243 points

‘A’ 
Bridges 

© Mike Iannuzzi 
234 points

‘A’ 
Into the Clouds 
© Alice Somma 

233 points
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‘A’ 
Busan Harbor Bridge 

© Christine Doyle 
230 points

‘A’ 
Brooklyn Bridge 

© Paul Grebanier 
228 points

‘A’ 
Penobscot Harbor Bridge 

© Marlene Schonbrun 
228 points
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‘A’ 
GW Bridge 

© Charles Levin 
226 points

‘A’ 
Bridge With Shadows 
© Virginia Lawrence 

221 points

‘A’ 
Winter Stroll 

© Mike Schleiff 
224 points
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Reflections 
by Evelyne Appel

Art is not a reflection of reality. It 
is the reality of a reflection. ~ 

Jean-Luc Goddard 

Many photographers enjoy 
taking pictures of reflections.    
I am one of them. In Autumn, 
reflections of trees wearing 
their golden and red hues 
mesmerize me. Ponds become 
beautiful spectacles.

In Turkey, you see many 
Roman ruins. For one 
particular ruin, everyone 
looked up.  I looked down into 
a large puddle of water. I  had 
my picture!  

In Ephesus, a tourist was 
wearing sunglasses. She let me 
indulge and take reflections of 
the Celsius Library. We had so 
much fun.

New York, New York offers 
you an abundance of 
reflections. In Soho, Kiki de 
Montparnasse lures you in. A 
bit of Paris came my way.

In Amsterdam, the canals 
all over the city are a real treat, 
as are the colorful buildings 
that offer you abstract subjects. 
It is glorious.

C
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All images 
© Evelyne Appel
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PDI Workshop 

The Club’s PDI (Projected 
Digital Image) Workshop    
was held on Thursday night, 
January 22nd. We looked at the 
two images submitted by five 
Club members for comments 
and possible alterations using 
Photoshop software. Over 20 
PWCCers were in the gallery 
and took part by offering 
comments and suggestions   
for improving the photos.

Here are some of the       
images that we worked on…
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Betsy Currier’s image of flamingoes at the Bronx zoo was colorful  
but we felt it could be improved. First we used the Crop Tool and 
removed the top ¼ of the image. We then inverted the image by 
going to Image > Image Rotation > Flip Canvas Vertical. Next, 
we went to Edit > Transform > Distort and pulled the image up 
from the top to elongate the birds’ reflections. Finally, we used the 
Spot Healing Brush to remove some of the blue distractions.

We all liked Mike Schleiff’s presentation of the flower but we felt that the interior border was too 
prominent. We used the Remove Tool to eliminate it. We then use the Rectangular Marquee Tool 
to select the central area and added a one pixel border to it  using Edit > Stroke.
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This architectural image by Evelyne 
Appel was interesting but we felt it 
lacked that extra “pop.” We created a 
new layer (Command/Control-J) 
Then went to Image > Adjustments > 
Shadows/Highlights… to lower the 
Shadows Slider to 0 and increase 
the Highlights Slider to 50% Voilá!

This scene of the Vinales Valley in 
Cuba was shot by Tom Quackenbush 
on a PWCC field trip in 2016. We held 
the Shift Key while using the Crop 
Tool, pulling down from the upper left 
corner to keep the same proportions 
of the image. This put slightly more 
attention on the farmhouse as well as 
eliminating the distracting smoke in 
that corner. We also reduced the  
brightness a tad using a Brightness/
Contrast Adjustment Layer.  



     February 2026 www.parkwestcameraclub.org 33

C
LU

B This black-and-white image of a lighting fixture by Helen Pine was 
considered by most of us as pretty close to perfect. One member 
present suggested removing the cloud-like shadows on the ceiling. 
The rest of us disagreed with this change.

Smartphone Zooming 

Zooming on a smartphone 
feels effortless. You pinch 
the screen, the subject gets 
closer, and the camera does 
the rest. But what actually 
happens when you zoom 
isn’t as simple as it looks—
and it explains why 
zoomed-in phone photos 
often lose detail, look noisy, 
or feel overly processed. 
Once you understand what 
your phone is doing behind 
the scenes, you can make 
better choices about when to 
zoom and when to avoid it. 

Smartphone zoom falls 
into three categories. Which 
one depends on how far you 
zoom, the lenses built into 
your phone, and the lighting 
conditions at the time. Here 
is the lowdown on each… 
• Optical zoom is the best-

case scenario. It occurs 
when your phone uses a 

• dedicated telephoto lens
—often labeled 2×, 3×, or 
5×. Instead of cropping 
the image, the camera is 
physically using a lens 
designed to see farther 
away. Because of that, 
image quality stays intact. 
You keep full resolution, 
clean detail, and more 
natural textures. 

• Digital zoom is what 
kicks in when your phone 
doesn’t have a lens that 
matches the zoom level 
you’ve chosen. Instead of 
moving glass, the camera 
simply crops the image 
and enlarges what’s left. 
No new information is 
captured—you’re just 
stretching fewer pixels to 
fill the frame. At low 
zoom levels in bright 
light, this can look okay. 
But as you zoom farther 

in, the image quality 
drops quickly. 

• Computational Zoom is 
used by smartphones to 
make zoomed images 
look better than they 
technically should. When 
you zoom beyond a lens’s 
capability, your phone 
may combine data from 
multiple lenses, merge 
several frames, and use 
AI-based processing to 
rebuild detail.
It’s often better for you 

to shoot wide and crop later 
rather than perform an in-
camera zoom—especially    
if you’re relying on the  
camera’s digital zoom.

Shooting wide preserves 
the full-resolution image 
and avoids extra processing. 
Cropping later gives you 
more control over how 
much detail you sacrifice.
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Essential P-P Steps 

1. Basic Adjustments
Start by converting a RAW file 
to . jpg, .psd, .tiff, etc. Adjust 
exposure, contrast, highlights, 
shadows, and white balance to 
correct any imbalances.

2. Improve Composition
Enhance composition by 
cropping unnecessary 
elements, straightening 
horizons, and applying 
compositional rules (e.g. Rule 
of Thirds) to improve the 
photo’s impact.

3. Enhance Details
Sharpen details selectively and 
apply noise reduction to 
maintain image quality. Focus 
on key areas to avoid an over-
processed look.

4. Adjust Color & Saturation
Beyond basic correction, color 
grade to add mood and depth. 
Adjust vibrance and saturation 
to make colors pop or to create 
a subtle palette.

5. Adjustments & Retouching
Utilize brushes and masks for 
targeted edits. In portraits, 
retouch skin and enhance eyes; 
in landscapes, focus on skies 
and textures.

6. Local Contrast Enhancement
Use techniques like dodging 
and burning or clarity 
adjustments to improve local 
contrast. This step adds depth 
and dimensionality to specific 
areas of the image.
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David Miller, our Club member in Scotland, publishes a 
monthly blog <www.cairngormslife.com> of images depicting 
his life in Scotland’s southwestern region of East Ayrshire.

All images 
© David Miller

The full moon

A weeping tree we have in the garden which we 
are not sure what it is until we get some foliage 
has just started budding up.

The Standing Stones of 
Dael Meallain Tuinn  
(meeting place at the 
mound with a motte)

The bull

http://www.cairngormslife.com/
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Photo by PWCC member
Bruce Byers

Ctrl/Cmd + Z: Undo/Redo 
– Quickly undo or redo the 
last action.
Ctrl/Cmd + J: Duplicate 
Layer – Quickly create a 
copy of your current layer.
Ctrl/Cmd + T: Free 
Transform – Resize, rotate, 
or warp the selected layer 
or object.
Ctrl/Cmd + L: Levels – 
Adjust the levels of the 
selected image or layer.
Ctrl/Cmd + M: Curves – 
Open the Curves dialog 
box to adjust tonality.
Ctrl/Cmd + Shift + N: New 
Layer – Quickly create a 
new layer.
Ctrl/Cmd + E: Merge 
Layers – Merge selected 
layers into one layer.
Ctrl/Cmd + Shift + S: Save 
As – Save your work in a 
different file format or 
location.

  ACC 

Athens
Cultural
Canter

24 Second St.
Athens, NY

Keyboard Shortcuts 

There was a time when MSDOS 
ruled the computer world. Then 
along came the first Macintosh 
and popularized the mouse and 
did away with most keyboard 
shortcuts. But there are still 
many you can use in Photoshop:
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PDI Workshop 2 

It’s not often that we hold a 
PDI (Projected Digital Image) 
Workshop on a Monday night 
at one of our meetings, but we 
had to improvise when one of 
our presenters had a death in 
the family. At the last minute 
we requested members to send 
in one image with which they 
wanted help in processing.

Here are some of the       
images that we worked on…
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Lilette Hubilla’s colorful image of the food truck vendor required a bit of 
work. Because of the angle at which the image was shot, we employed 
Edit > Transform > Distort to straighten top and bottom of the vehicle. 
We Cropped the image to emphasize the man (putting him on a Rule of 
Thirds line). Next, we used the Remove Tool in the Camera RAW filter  
to get rid of the people in the background.

We all liked Sonia Durante’s selective color shot of the 
bride taken on one of our summer meetings to Brooklyn 
Bridge Park. We were bothered by the blown-out water  
between the two people. We used the Magic Wand Tool  
to select and delete the bright area between the couple. 
Then we used the Lasso Tool (L) to select some of the 
water to the right of the dress, pasted it on its own layer 
using Command/Control - J, and finally used the Move 
Tool (V) to drag the water to fill in the empty space.
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Laughing by Evelyne Appel needed a few alterations. 
First, we used the Crop Tool and cut off some of the 
image from the left side. Still using the Crop Tool, set 
to Generative Fill, in the Menu Bar, we pulled down 
from the bottom and clicked the √.This added the rest 
of the shoes and some added space. Next, we used 
the Remove Tool to eliminate the tree between the two 
men. Finally, we used Hue/Saturation Adjustment 
Layer to reduce the brightness of the greens in the 
image so the men would “pop” from the background.

Marlene Schonbrun’s shot of the Enid Haupt Conservatory was too expansive and we felt the 
bald sky was too distracting. We used the Crop Tool to tighten the image using the pumpkins 
as Leading Lines to draw the viewer’s eye up the stairs and to the doors.
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We felt Natalie Manzino’s Trio was a little busy. We used Edit > Transform > Distort and pulled down on the lower 
left corner to straighten the grill. Next, we chose the Crop Tool to eliminate unwanted area on the top and both sides 
of the image. This made the dogs more prominent in the frame.

We all liked the mystery of 
Hedy Klein’s Grand Entrance 
with all its reflections. We left  
it as it was. 

We passed over Vortex by 
Barry Fahrer since he was not 
is attendance the the PDI 
workshop meeting. (Maybe 
next month.)
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Mike Schleiff shared this image of reflections. We liked it but felt it needed a bit more “zip” to make it jump off 
the screen. We used Image > Adjustments > Shadows/Highlights… and moved the Highlights Slider to the 
right. This brought out some unnoticed colors in the image so we used a Hue/Saturation Adjustment Layer to   
reduce all the colors to 0 (except for the Blue Channel).

Helen Pine used this image of her home in Delray Beach, Florida to demonstrate the sky replacement feature 
in Photoshop. She went to Edit > Sky Replacement to open the Sky Replacement Dialog Box. She then 
scrolled through the assortment of skies and chose this darker blue, almost cloudless sky (being mindful to pick 
a sky that matched the intensity and direction of the lighting in the original image) and simply clicked on OK.
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About (Y)our Website 
by Michael Schleiff

Park West Camera Club’s web-
site offers an array of topics for 
your review. The site should be 
your go-to place to get infor-
mation regarding the Club. 
Following is just a partial list 
of sections that can be found 
on the website:

• Home Page—This is our face 
to the Internet world. On it is 
a listing of all the latest news 
and upcoming schedule of 
events. We highlight the    
latest competition winners in 
a continual loop for everyone 
to see. In addition, there’s a 
direct link to the latest 
edition of Photo Notes. New 
issues are uploaded immedi-
ately upon their release each 
month. Finally, under the 
masthead, there is a menu 
area that lists 12 different  
areas of various Club info, 
some of which are:

• Newsletters—10 years of  
past Photo Notes issues are 
currently available online 
and may be downloaded.

• Organization—features the 
latest PDF files containing 
membership information                 
including the Park West  

Constitution and Bylaws. In 
addition, there is a “Resource 
Link” submenu. Listed here 
are web links to various 
imaging-related websites.  
Included are sites offering 
Photoshop and Lightroom 
help. We are always looking 
to add links, so if you have 
any photography-related 
websites that you would like 
to add, please contact us.

• Competition Manual &     
Labels—this is where the 
Monthly Judging Guidelines 
and Competition Manual are 
to be found. The Competition 
Manual includes detailed 
specifications on presenting 
PDI images for entry into 
competitions.

• Member Galleries—are 
available to show your work 
on the web. They can be    
accessed in the Member   
Galleries Menu or directly 
from any web browser by 
searching Park West Camera 
Club and your name. The       
instructions for setting up     
a gallery may be found at  
the first dropdown in the 
Club Members Galleries 
menu “Instructions to Create 
a Members Gallery.” If you 
have any questions about  
uploading your images, 

please follow up with the 
website committee.

• How-to Videos, Notes, and 
Speakers—all speaker talks 
have been recorded and     
uploaded to the website.      
In addition, we have how-to 
videos covering various 
techniques to help editing 
your photographs.

Your Website Committee is  
continually uploading new 
and exciting information to the 
website. The goal is to make 
<www.parkwestcameraclub.org> 
a primary source for Club and 
imaging information. We are 
always looking to expand the 
website. If you have any ideas, 
please contact Michael Schleiff 
or Christine Doyle.

C
LU

B

Mistake to Avoid 

Overdoing Edits and Effects

The attraction of filters and 
effects can be quite strong. 
However, over-editing can 
make photos look unnatural 
and unappealing. Learning 
restraint in editing your 
images is key to success. You 
should develop a personal 
style that complements your 
photos, not overpowers them.

http://www.parkwestcameraclub.org
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Express It! 

Background Removal—Free

The free Adobe Express 
background remover will 
automatically detect and 
remove the background from 
your images. You’ll end up 
with a clean, isolated subject 
that you can use in any project 
or program you want. 

No photo editing skills are 
needed. No credit card is 
required. This free tool is 
available to everyone. It can  
be used on just about any 
device including computers, 
phones, tablets, and more. 

The Adobe Express 
Background Remover is an 
automatic tool. There are no 
steps you need to take to make 
a cutout. Just drag and drop an 
image (it must be a JPEG, JPG, 
PNG, or WebP and no larger 
than 40MB in size) HERE. (The 
Background Remover can also 
be downloaded to your copy 
of Adobe Express.)

In a few seconds you will 
be able to download your 
background-less photo.
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We received the following 
email from a new software 
developer. It sounds quite 
interesting for film shooters!
But we have no idea about 
this person or his product. 
As usual, caveat emptor.

Hi there,
My name is Vincent, and 

I'm an independent designer 
and developer with a passion for 
film photography.

I created Frames, a note-
taking app for film 
photographers that lets you 
record all your shot data while 
you're out shooting: shutter 
speed, aperture, GPS location, 
date/time, and more.

What makes Frames 
different is that it automatically 
embeds this information as 
EXIF metadata into your 
scanned images, so your film 
photos carry the same detailed 
data as digital files.

I built this app out of my 
own frustration with losing 
track of my settings in the field. 
I thought it might be useful for 
your members, and I'd really 
appreciate it if you could share 
it with your community.

Right now Frames is 
available for iPhone and Mac, 
with Android and Windows 
versions coming in the next  
few months.

You can learn more here: 
<https://apps.apple.com/us/app/
frames-film-notes/
id6744057317>

Thanks so much for your 
time, and happy shooting!
Best, 
Vincent Tantardini

https://apps.apple.com/us/app/frames-film-notes/id6744057317
https://apps.apple.com/us/app/frames-film-notes/id6744057317
https://apps.apple.com/us/app/frames-film-notes/id6744057317
https://apps.apple.com/us/app/frames-film-notes/id6744057317
https://www.adobe.com/express/feature/image/remove-background?clickref=1100lBUA9aRN&mv=affiliate&mv2=pz&as_camptype=&as_channel=affiliate&as_source=partnerize&as_campaign=pz-shotkit
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Perceptual Megapixels 
 Jeff Langford

For many PWCC members 
the issue of photographic 
sharpness may be of little   
concern. After all, we share  
our work through various on-
line resources and evaluate the 
resulting images on a monitor 
where the images are rarely 
larger than about 8x10 inches. 
Furthermore, based on the size 
of the membership in our Print 
Salon, very few Club members 
make (or have professionally 
made) high-quality prints to 
hang on a wall—ones in which 
the sharpness of the image 
might become a factor in its 
final presentation.  

But judging from the quan-
tity of high megapixel cameras 
on the market these days, it 
seems fair to conclude that  
image sharpness is of concern 
to at least a few of us, myself 
included. Cameras with sen-
sors in the range of 45-60MP 
are becoming ever more popu-
lar as major photo companies 
keep pushing the idea that 
20-24MP just won’t suffice any 
longer. But, of course, these 
high megapixel cameras come 
at a price, and the question fac-
ing anyone thinking of invest-
ing $3,500 in a camera body, is 
whether this kind of camera is 
really going to improve our 
images if we don’t intend to 
make museum-size prints. 
Have we actually wasted our 

money buying into the adver-
tising hype surrounding these 
“professional” cameras?  

I think this question needs 
some thought because many of 
us have never investigated the 
various factors that influence 
image sharpness. Take, for   
example, the impact of com-
puter monitors on the percep-
tion of sharpness. Nearly all 
computer monitors have reso-
lution limits of at best 8MP 
(e.g., 4K, 3840x2160). If the res-
olution of a computer monitor 
is so severely limited, can we 
then assume that all the 
megapixels on a camera sensor 
beyond the resolution limit of 
our screens will not be per-
ceivable. The popular YouTube 
photography guru Simon 
d’Entremont (Canadian nature 
and wildlife photographer) 
discusses this issue of “percep-
tual” megapixels fairly often 
on his channel, pointing out 
that the greater detail in a 
45MP image compared to a 
20MP image is rarely seen    
either online or in an average-
size print. 

It turns out that another 
(among many) of the reasons 
for this comes down to the 

quality of our lenses in 
determining the overall 
sharpness of a photo— 
an issue to which most of 
us probably give little  
(or no) thought. 
    The website DXOMark 
posts the actual resolving 
power of lenses from     

 major manufacturers, 
and it’s surprising to discover 
that most of these lenses can’t 
resolve the full number of   
pixels on any given camera 
sensor. So, if I  am reading the 
test results correctly, my excel-
lent Olympus 75mm f-1.8 lens 
can only resolve 15 of the 
20MP on my camera’s sensor. 

I raise this question 
about “perceptual” megapixels 
because I own both a 20MP 
Canon R6 and a 45MP R5, and 
when I examine my images  
online at a 100% enlargement, 
I’m sure I see more detail in 
the R5 images on my computer 
screen. But if the resolution 
limits of computer monitors 
are an established fact, how is 
this possible?  

I don’t think my eyes are 
fooling me. 

Further complicating this 
issue is that prints made from 
my R6 camera and from the R5 
look the same, even in a 32x24 
inch enlargement. Clearly, 
printers contribute to the    
perception of detail in an     
image as well, and my inex-
pensive desktop printer is
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Continued on next page…
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painfully inadequate for mak-
ing quality prints.

One last thought about   
image sharpness: I know many 
photographers simply resort to 
various post-processing tech-
niques to add apparent resolu-
tion to their images. I say   
“apparent resolution” because 
most of these post-capture 
sharpening techniques (which 
the PWCC Print Salon has    
recently been exploring) look 
highly artificial to my eyes 
since they are based, as I     
understand it, on techniques 
that involve increasing edge 
contrast between objects of  
differing luminosity without 
actually increasing image     
detail. And programs such as 
Topaz Gigapixel do nothing 
but interpolate pixels that are 
already in an image to increase 
the size of the file. This opera-
tion has no impact on sharp-
ness because the program can’t 
create pixels that aren’t already 
in the original digital file.

The issue of image sharp-
ness as a product of perceived 
megapixels is, I’m sure, far 
more complex than this little 
article has already suggested. 
As I strive for the best presen-
tation of my photographic 
work, I struggle with this    
subject on a regular basis. 

Any thoughts or insights 
on whether my understanding 
of image sharpness is accurate 
are most welcome.
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Apple Creator Studio 

Apple recently released a 
new suite of apps aimed at 
artists and other creatives 
<Apple Creator Studio> It 
includes apps like Final Cut 
Pro, Logic Pro, Pixelmator 
Pro, and more, all bundled 
together. Previously, these 
apps could be purchased 
separately for iPhone, iPad, 
or Mac, but now, they’re all 
available for purchase for a 
monthly fee of $12.99 or $129 
for a one-year subscription. 
(This suite of apps is a less 
expensive alternative to 
Adobe’s Creative Cloud.)

Of particular interest to 
Club members is the latest 
version of Pixelmator Pro, 
Apple’s image-editing app.   
It brings an approachable  
and professional editing 
experience to even more 
creators. Pixelmator Pro is 
packed with powerful image 
editing tools, empowering 
Apple Creator Studio 
subscribers and one-time-
purchase for Mac users to 

design, draw, paint, and 
refine their creative vision, 
and so much more. For the 
first time, Pixelmator Pro is 
coming to iPad, bringing an 
all-new touch-optimized 
workspace, full Apple Pencil 
support, the ability to work 
between iPad and Mac, and 
all of the powerful editing 
tools users have come to 
appreciate on Mac.

Only time will tell if this 
Creative Studio suite will be 
able to compete with the 
Creative Cloud—especially 
for those of us in the rapidly-
changing world of image 
processing and manipulation.

https://click.iphonelife.com/ga/click/2-11080875-5-15213-220128-7611754-77fa74cdb0-9gb4f30a0e
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Creative Snow Tips 
by Susan Magnano

These winter photography tips 
are designed to help you move 
beyond “pretty snow scenes” 
and start creating images with 
intention, mood, and story.
[Susan Magnano was a guest 
speaker at the Club last year.]

1. Overexpose Intentionally 
Snow should be white, not 
gray. Start at +1 to +2 EV 
and confirm with your 
histogram. If your snow 
looks dramatic but dull, it is 
underexposed. 

2. Expose to the Right          
Snow fools your eyes in 
bright conditions. Use the 
histogram, not the LCD. 
Push whites to the right 
without clipping highlights. 

3. Simplify  
Snow hides clutter. Use that 
advantage. Strip the frame 
down to shape, line, gesture, 
and negative space. 

4. Use Weather as Texture 
Falling snow, fog, blowing 
spindrift, and low contrast 
skies add depth and mood. 

5. Choose Your Shutter Speed 
Fast shutters will freeze 
snowflakes for texture. Slow 
shutters streak snow for 
motion and atmosphere. 

6. Lock Your White Balance 
Auto white balance drifts 
wildly in snow. Set a fixed 
Kelvin temperature and 
decide whether you want 
clean, cool whites or warm 
emotional tones. 

7. Add Scale or Story 
Add a person, footprints, ski 
tracks, etc. A single pop of 
color turns a snow scene 
from pretty to purposeful. 

8. Mind the Sky 
Blank white skies kill 
images. Crop them out, wait 
for texture, or use them 
intentionally as negative 
space. You can also try using  
a sky replacement. 

9. Edit with Restraint 
Avoid crushing contrast or 
over-clarifying snow. 
Preserve subtle tonal 
transitions throughout.
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Mistake to Avoid 

Relying Too Much on P-P
In the age of digital photos, 
it’s easy to fall into the trap 
of “fixing it in post.” While 
post-processing is a useful 
and powerful tool, relying 
on it too heavily can be a 
crutch. Beginners often 
overlook “getting it right in 
the camera” first, which is 
crucial for authentic and 
high-quality images.
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Digitizing Old Photos 

Many of us have been doing 
photography for a long time—
years, maybe even decades. 
We’ve got drawers and boxes 
filled with old prints, negatives 
(both color and black and 
white), and slides. What are we 
to do with them?

As I see it, there are three 
choices…
1. close the drawer or shove 

the box to the back of the 
top closet shelf

2. dump them in the circular 
file (aka trash can)

3. scan them

If you choose number 3 you 
have another decision to make. 
How am I going to digitize 
them? Here are four methods 
you can opt for…

• use a scanner—many of us 
already have one, a flatbed 
scanner, built into our multi-
function printer; but these 
don’t always give the best 
quality; there are stand-
alone flatbeds that can do a 
better job on prints and even 
film; if you’ll only be doing 
slides and negatives, a film 
scanner might be your best 
choice; both can be costly.

• use a digital camera—for 
scanning prints 
you’ll need a 
copy stand or a 
tripod with an 
inverted center 
column or a 
boom arm;       
a macro lens 
works best for this task;     
be careful to eliminate any 
reflections and glare; you 
might need a piece of clear/
colorless glass or plastic to 
keep the print flat;                     
for scanning film you’ll 

need a slide 
copying attach-
ment that fits 
your camera 
(most also do                         
negatives).

• use a smartphone—these 
are not for making large 
prints; the photo app on 
your phone might do the 
trick but other apps are 
available such as Photoshop 
Express, Google PhotoScan, 
Microsoft Office Lens, etc.

• use a professional service— 
these are most likely to give 
you the best results but may 
cost more and take more 
time; there are many right 
here in the Big Apple (Pro 
Image Photo, LTI, White 
Glove, etc.), but there are 
also many mail-order digi-
tizing options including 
ScanCafe, DigMyPics, and 
many more.
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DxO Labs has just upgraded 
and improved the entire NIK 
collection of plug-ins. Here’s 
some of what to expect…

• They’ve boosted perfor-
mance by 30%, added su-
per-useful quick export op-
tions, and you can switch 
seamlessly between plug-
ins in a heartbeat.

• Both Silver Efex and Color 
Efex have new workflows, 
new filters, brand new 
sliders, and new local ad-
justment functionality.

• For Photoshop users 
there’s a beautiful new 
panel, mask functionality 
is on another level, and re-
turning to Photoshop 
comes with loads of op-
tions for layers and Smart 
Objects.

• There’s a new Paper Tex-
tures tool in Nik Analog 
Efex—the perfect way to 
add depth, tactility, and 
storytelling power to your 
images. 

$169.99 
Lifetime license. 
No subscriptions. 
No hidden fees.
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Mistake to Avoid 

Neglecting the Importance of 
the Subject

Sometimes, in the quest to 
get technically perfect shots, 
photographers forget about 
the soul of the photograph—

the subject. Whether it’s a 
person, a landscape, or a 
street scene, understanding 
and connecting with the 
subject is vital. It’s this 
connection that breathes life 
into a photograph.

Smartphone Zooming 

Zooming on a smartphone 
feels effortless. You pinch 
the screen, the subject gets 
closer, and the camera does 
the rest. But what actually 
happens when you zoom 
isn’t as simple as it looks—
and it explains why 
zoomed-in phone photos 
often lose detail, look noisy, 
or feel overly processed. 
Once you understand what 
your phone is doing behind 
the scenes, you can make 
better choices about when to 
zoom and when to avoid it. 

Smartphone zoom falls 
into three categories. Which 
one depends on how far you 
zoom, the lenses built into 
your phone, and the lighting 
conditions at the time. Here 
is the low-down on each… 
• Optical zoom is the best-

case scenario. It occurs 
when your phone uses a 
dedicated telephoto lens
—often labeled 2×, 3×, or 
5×. Instead of cropping 
the image, the camera is 
physically using a lens 

designed to see farther 
away. Because of that, 
image quality stays intact. 
You keep full resolution, 
clean detail, and more 
natural textures. 

• Digital zoom is what 
kicks in when your phone 
doesn’t have a lens that 
matches the zoom level 
you’ve chosen. Instead of 
moving glass, the camera 
simply crops the image 
and enlarges what’s left. 
No new information is 
captured—you’re just 
stretching fewer pixels to 
fill the frame. At low 
zoom levels in bright 
light, this can look okay. 
But as you zoom farther 
in, the image quality 
drops quickly. 

• Computational Zoom is 
used by smartphones to 
make zoomed images 
look better than they 
technically should. When 
you zoom beyond a lens’ 
capability, your phone 
may combine data from 
multiple lenses, merge 
several frames, and use 
AI-based processing to 
rebuild detail.
It’s often better for you 

to shoot wide and crop later 
rather than perform an in-
camera zoom—especially    
if you’re relying on the  
camera’s digital zoom.

Shooting wide preserves 
the full-resolution image 
and avoids extra processing. 
Cropping later gives you 
more control over how 
much detail you sacrifice.
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Where to Go 

Castles  of the Northeast

A castle is an architectural 
marvel that represents a time   
in history. When you think of a 
castle, you may automatically 
picture an old ruin in Europe. 
Luckily for us metropolitan 
area photographers, we have 
castles of our own right here in 
the Northeast. And, best of all, 
no passports are required. 
Here are a few of them, listed 
in order of their distance from 
midtown Manhattan… 

Kip’s Castle
Montclair, NJ 
20 miles

Oheka Castle
Huntington, NY
30 miles

Van Slyke Castle
Wanaque, NJ 
35 miles

Bannerman Castle
Beacon, NY
60 miles

Hearthstone Castle
Danbury, CT 
65 miles

Gillette Castle *
East Haddam, CT 
125 miles

Winnekenni Castle
Haverhill, MA 
235 miles

Hammond Castle Museum *
Gloucester, MA 
255 miles

Boldt Castle
Alexandria Bay, NY 
355 miles

The castles marked with an * 
have been destinations of Park 
West Camera Club field trips.
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Click on the castle names 
for additional information.

https://essexcountyparks.org/parks/kips-castle-park
https://www.oheka.com/
https://www.atlasobscura.com/places/van-slyke-castle-ruins-2
https://bannermancastle.org/
https://tarrywile.com/hearthstone-castle/
https://ctparks.com/parks/gillette-castle-state-park
https://www.haverhillma.gov/parks-recreation-culture/parks-trails-and-conservation-areas/conservation-areas/winnekenni-park/
https://hammondcastle.org/
https://www.boldtcastle.com/visitorinfo/
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Composition Techniques 

Club member Mike Iannuzzi 
compiled this list of over three 
dozen composition techniques. 
How many of them do you 
know? More importantly, how 
many of them do you use?

1. Rule of thirds
2. Strong lines
3. Leading lines–lines that 
draw the viewer’s attention to 
the main subject
4. Curved lines create sense of 
flow–S-Curve directs eye 
movement through the frame, 
sensuality, motion. 
5. Parallel lines e.g. train 
tracks, bench slats, diagonals – 
tension, discord 
6. Dynamic diagonals–tension, 
discord, dynamism
7. Center and Symmetry–bal-
ance in the frame. Inverted T 
and V arrangements (the sub-
ject in the center and the other 
elements at the base or along 
the V)
8. Rule of space–space in front 
of where the subject is moving 
to create motion 
9. Negative space–empty space 
around the subject
10. Patterns
11. Pattern breaking–an ele-
ment that breaks the pattern 
and draws attention 
12. Frame in frame–natural or 
man-made elements to create a 
frame around a main subject, 
guiding the viewer's eye, 
adding depth, and providing 
context

13. Fill the frame–getting up 
close to the subject–little nega-
tive space
14. Figure ground-moving the 
subject to edge gives the sub-
ject importance
15. Diminishing perspective– 
gives depth; e.g., train tracks 
going to vanishing point
16. Strong shapes–using prom-
inent shapes to guide the 
viewer's eye, create balance, 
and evoke emotion, whether 
through simple objects, the 
arrangement of elements, or 
negative space. For example, 
using strong triangular shapes 
for a sense of upward move-
ment or using circular shapes 
to create a feeling of calm
17. Low/High angle–changing 
angle can emphasize other   
elements in the frame
18. Rule of odd number–odd 
number of elements within 
frame is more interesting 
19. Layering–interesting items 
in background, middle 
ground, and foreground
20. Multiple points of interest 
This works for scenes with 
many subjects, like crowds, but 
requires management of visual 
weight to maintain a unified 
story and avoid confusion
21. Triangular form(s) of the 
elements–upright equilateral 
triangle gives stability, power
22. Juxtaposition–two elements 
that contrast each other–e.g. 
young and old
23. Cross composition–ele-
ments in four quadrants

24. Symmetrical composition 
where subject mirrors itself
25. Isolate the subject using 
shallow depth of field
26. Decisive moment ala Henri 
Cartier-Bresson
27. Human interest–placing a 
human element in the frame
28. Black and white to demon-
strate contrast and to eliminate 
when colors are distracting
29. Analogous color–3 or 4 ad-
jacent hues on the color wheel
30. Complementary colors
31. Monochromatic–gradations 
of a color
32.Contrast–light and dark, 
warm and cold colors
33.Texture–surface quality of 
an object to add visual interest
34. Simplicity–only what is  
essential is in the frame
35. Isolate the subject 
36. Foreground interest–blur 
background
37. Radial composition– 
arrange elements to radiate 
outward from a central point
38. Left to right rule–place el-
ements left to right as we read
39. Story telling e.g. migrant 
mother, the kiss
40. Golden Triangle–Divide the 
frame into four triangles by 
drawing a diagonal line from 
one corner to the opposite, 
then drawing two perpendicu-
lar lines from the remaining 
corners, creating a guideline to 
place your subject within one 
of these triangles
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Photo Shorts 

B&W Only

RICOH recently announced a 
new variant of their much 
sought-after point-and-shoot 
camera: the GR IV Monochrome. 
While retaining the same 
compact form factor and 
exceptional image quality of 
the original, this version has 
been designed exclusively for 
monochrome (aka B&W) 
photography. This was 
achieved by removing the 
color filter from the sensor, 
thus delivering richer tonal 
gradation. In addition, a red 
filter has been added to create 
a bold and dramatic (high 
contrast) look to images taken 
with the camera. All this for a 
mere $2,199.95.

UltraFine Monitors

LG recently released a new line 
of computer monitors that are 
designed for high-end video 
and photography. The LG 
UltraFine evo 32U990A-S is a 
31.5” 16:9 LCD with HDMI, 
DisplayPort andThunderbolt 5 
connections. It measures 6,144 
x 3456 pixels, has a 2,000:1 
contrast ratio and more. Best of 
all, 99.5% AdobeRGB coverage. 
The price is (are you seated?) a 
mere $1,996.99. Other sized 
monitors in the evo line will 
also be available. 

ColorPro Monitors

Designed to complement the 
Mac aesthetic, ViewSonic’s 
premium ColorPro displays 
offer 4K and 5K resolution and 
professional-grade color 
accuracy. The line includes 24,” 
27,” and 32” models. All are 
high resolution monitors with 
100 watts of power. Ports 
include Thunderbolt 4, HDMI, 
DisplayPort options, plus a 
USB-C and USB-A hub. The 
stand allows you to customize 
height, tilt, and swivel for 
maximum comfort. The prices 
range from $549.99 to $949.99.
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Canon Goes Wide

Canon’s RF mirrorless 
system is gaining two new 
wide-angle lenses, the  

14mm f-1.4 L VCM and the 
7-14 f-2.8-3.5 L Fisheye STM. 
The 14mm prime lens is the 
company’s brightest ultra-
wide ever. The 7-14mm 
fisheye zoom covers a class-
leading 190º angle of view at 
the wide end. In addition to 
their dust- and weather-
resistant sealing, both lenses 
are lightweight and short. 
The list prices are $2,599 and 
$1,899, respectively.

Mistake to Avoid 

Not Backing Up Photos

Losing photos due to a 
technical glitch or a lost 
device is heartbreaking. 
Many photographers often 
overlook the importance of 
regularly backing up their 
work. You must invest in 
storage solutions (external 
hard drives, cloud storage, 
etc.) and develop a habit of 
backing up after every shoot.

You’ll be glad you did!
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Using Your Camera 
by Chuck Pine

Shoot the Moon

The moon is brighter than you 
think. A good rule of exposure  
is known as the Sunny 16 Rule.
(After all, the moon is being lit 
directly by the sun.) Set the 
shutter speed to 1 over the   
focal length of the lens (for   
example, a 300mm lens should 
be set to 1/300 second, or close 
to it) and set the aperture to 
f-16. To be safe, bracket on both 
sides (f-11 and f-22)

Because the moon is so small 
in the sky, try to use a lens that 
is at least 200mm. Since the 
moon is constantly in motion, 
try not to use a shutter speed 
slower than 1/60th second. 
And for the best results, use a 
tripod and a remote shutter 
release (wired or wireless).

The best time to capture a 
bright moon over a landscape 
or cityscape is the Blue Hour, 
just before the sky becomes 
completely black.
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There are two ways to shoot 
the stars in the sky. One is a 
long exposure to create star 
trails. The other is to use a not-
so-long exposure to keep the 
stars as points of light. 

The problem is that the 
Earth is constantly moving—
rotating on its axis. This is 
what makes star trails circular 
lines—they’re circles or arcs 
(remember your high school 
geometry class?). 

The 600 Rule allows you to 
calculate the longest exposure 
time you can use…

Take 600 and divide it by 
your selected focal length to 
get the longest exposure time 
you can use before the stars 
turn from points of light to 
lines of light. For example if 
you’re shooting a 100mm lens, 
then your maximum shutter 
time would be: 600/100mm =  
6 seconds before the star trails 
become noticeable.
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Photo Shopping 
by Chuck Pine

Senior Cameras

Shotkit, the website and photo 
school, came out with their list 
of the five best digital cameras 
for seniors (or those with other 
physical limitations). This list 
focuses on comfort, portability, 
ease of use, and performance.  

Best Compact Camera
Canon PowerShot V1
Pros

• Compact and portable
• User-friendly
• Easy to navigate
• Pro controls if desired

Cons
• More video-centric
• Lacks an EVF

$849

Best Bridge Camera
Panasonic LUMIX FZ80D
Pros

• 20-1200mm focal range!
• Lightweight\ portable

Cons
• Struggles in low light

$497.99 

Best Mirrorless Camera
FUJIFILM X-S20
Pros

• Lightweight/compact
• Fujifilm’s colors
• Interchangeable lenses

Cons
• No weather sealing

$1,499

Best Lightweight Compact
OM System Tough TG-7
Pros

• Indestructible
• Pocketable and 

lightweight
• Usable underwater
• Simple control system

Cons
• Poor low-light 

performance
$549.99 

Best Instant Film Camera
Fujifilm Instax Wide 400
Pros

• Retro film vibe
• Simple analog camera 

system
• Instant film images are 

fun
• Great for family events

Cons
• Requires 4 AA batteries
• Big and cumbersome

$175.95 (plus film)

Best All-Around Camera
Sony RX1R III
Pros

• 61MP Full-Frame
• ZEISS 35mm f-2 Lens
• Interchangeable lenses

Cons
• Expensive

$5,098
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Mistake to Avoid 

Ignoring Lighting Conditions

Light is the essence of 
photography. Photographers 
frequently disregard the 
quality, direction, and color of 
light. Shooting in harsh 
midday sun or with improper 

indoor lighting leads to 
unflattering shadows and 
colors. Understanding the 
golden hour, diffused 
lighting, and the basics of 
artificial lighting, among 
other things can dramatically 
improve your images.
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PhotoShopping 
by Chuck Pine 

Creating Sun Rays

Sometimes you take a great 
sunset shot but you feel it’s 
missing that something extra. 
Crepuscular rays (visible shafts 
of sunlight that radiate from a 
single point in the sky) might 
be your solution. Here’s how…

Open the image to which you 
want to add the sun rays. 

Create a new blank layer with 
Layer > New > Layer).

Use the Paint Bucket 
Tool and fill the blank 
layer with the color 
Black. (Be sure the 
Color Picker is set to 
Black and White 
with black on top.)

Go to Filter > Render >       
Difference Clouds to create     
a black-and-white pattern

    Next, go to Filter > Blur >   
    Radial Blur. Set the Amount  
    to 90 and the Blur Method  
    to Zoom. Drag the center of 
    the blur diagram to be on  
    top of the sun.

Finally, click on the Layer of 
the Difference Clouds and 
change its Blend Mode from 
Normal to Overlay. (You can 
also try other blend modes.)
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…is a camera setting that tells 
your camera what the color 
‘white’ should actually look 
like. Many of us ignore this 
setting when we’re shooting. 
Not to worry—WB can easily 
be corrected in Adobe Camera 
RAW or Lightroom.

In the Basic Panel, go to Color 
and find the White Balance 
sliders.

If the image is too Blue, move 
the Temperature Slider to the 
right; if it’s too Yellow, move 
the slider to the left.

Voilá—corrected!
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B & H Event Space 

The B&H Photo Event Space 
offers an array of free seminars 
and inspirational lectures by 
talented pros from around the 
world. Register online to make  
sure  your spot is reserved.

Mon, Feb 9
Photowalk—Central Park
Speaker: Tony Gale

Thu, Feb 12
Event Photography
Speaker: Vail Fucci

Wed, Feb 18
Bird Photography
Speaker: Isaac Grant

Mon, Feb 23
What Lens Should I Use?
Speaker: Tony Gale

Wed, Feb 18
Birds in the Everglades
Speaker: Matt Matkin

Thu, Mar 5
On-Camera Flash
Speaker: Tony Gale

Thu, Mar 10
Sports & Storytelling
Speaker: Jean Fruth and   
   David Burnett
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More Keyboard Shortcuts 

Ctrl/Cmd + Alt/Opt + 
Shift + E: Stamp Visible – 
Combine all visible layers 
into a new layer without 
flattening the image.
Ctrl/Cmd + R: Show/
Hide Rulers – Toggle 
rulers on and off for 
precise measurements.
Ctrl/Cmd + ‘: Show/
Hide Grid – Toggle the 
grid view for aligning 
objects.
Ctrl/Cmd + / –: Zoom In/
Out – Quickly zoom in or 
out of your image.
Spacebar: Hand Tool – 
Hold down to 
temporarily switch to the 
Hand Tool for navigating 
around the image.
Ctrl/Cmd + Alt + Shift + 
K: Show Keyboard 
Shortcuts – Display a list 
of all Photoshop 
shortcuts.

Ctrl= Control (Win)
Cmd= Command (Mac)
Alt= Alternate (Win)
Opt= Option (Mac)
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New Life Photos is Jamie 
Konarski Davidson’s website. 
You might remember Jamie 
from the workshop she gave to 
the Club in December on the 
subject of Motion and Multiples. 
In addition to the presentation 
she does online, Jamie offers 
in-the-field workshops. Here 
are some of her upcoming 2026 
offerings that might be of 
interest to PWCC members… 

Longwood Gardens Immersion 
April 21st-25th
Kennett Square, PA

Infrared in the Gardens 
June 25th-28th 
Richmond, VA

Finger Lakes of New York 
September 15th-19th 
Penn Yan, NY

Fall Color in West Virginia 
October 6th-10th 
Davis, WV

Eastern Shore Photo Workshop 
November 4th-8th 
Chincoteague Island, VA

Info and registration…
<www.newlifephotos.com>
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All images 
© Jamie Konarski Davidson

http://www.newlifephotos.com
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National Wildlife magazine’s 
55th annual photo contest is 
now open for submissions 
through March 22nd. All 
entries support the mission of 
the NWF—ensuring wildlife 
and people thrive in a rapidly 
changing world. Amateur and 
professional photographers 
alike are encouraged to share 
their best images of wildlife 
and wild lands, from around 

the world and their own 
backyards. Good luck!

Submissions in the following
categories:
• Baby Animals: Young of 

any species 
• Birds: Of any species
• Landscapes & Plants: From 

broad vistas to single 
blooms

• Mammals: Of any species

• Mobile: Taken with phones 
or tablets

• Other Wildlife: Fish, 
reptiles, amphibians, 
insects, spiders, macro, etc.

• People in Nature: Enjoying 
wildlife or the outdoors 

• Portfolio: A collection of up 
to 10 images built around a 
common theme related to 
nature or conservation

The entrance fee is $20.

More info/or to register, go to 
<photocontest.nwf.org>>
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This is a brand-new event 
designed from the ground 
up for true beginners—the 
people who need a slower 
pace, clear explanations, 
and step-by-step guidance 
starting from square one. 
It's also for users who want 
to make sure that their 
foundations are strong. 

 

The Foundations Summit is 
different on purpose:
• Slower pace (there are  

no “jumping ahead” 
assumptions)

• Starts from the basics 
(tools, layers, selections, 
adjustments, workflow, 
and much more)

• Clear, beginner-friendly 
instruction that builds 
confidence step by step

February 23 - 27, 2026 

An amazing 5 days of 
practical training from 16 
world-class professional 
Photoshop educators 

Watch class recordings for 
48 hours after presentation 
(no extra charge)
VIP Pass (lifetime access to 
class recordings, plus 
exclusive bonuses for $159)

<www.pvsfoundations.com>

http://photocontest.nwf.org
http://www.pvsfoundations.com
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M&M Photo Tours, the group 
that took PWCC to Cuba a few 
years back, has three specials 
they are offering for the new 
year. You. must book and place 
a deposit by February 14th to 
get these discounts…

The first is a trip to Brazil and 
the Pantanal for Jaguars - 10% 
off the published price!
Jaguars of The Pantanal | mm-
photo-tours

The second trip is their annual 
safari to Botswana - $1,000 off 
the published price!
Botswana 2026 | mm-photo-
tours

The third trip is their annual 
photo journey to Alaska for 
grizzly bear and more - $500 
off the published price!
Bears of Alaska 2026 | mm-
photo-tours

You will be right in the heart of 
the action on each trip. M&M 
uses local, professional guides 
who know the area, wildlife, 
and photographers’ needs. 
Small groups ensure that 
everyone gets the attention 
they need and plenty of field 
shooting time.
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https://www.mmphototours.com/jaguars-of-the-pantanal-2026
https://www.mmphototours.com/jaguars-of-the-pantanal-2026
https://www.mmphototours.com/botswana-2026
https://www.mmphototours.com/botswana-2026
https://www.mmphototours.com/bears-of-alaska-2026
https://www.mmphototours.com/bears-of-alaska-2026
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Sierra Photo Meetings  
     2025-2026

The New York City Sierra 
Club Photo Committee has 
meetings scheduled for the 
2025-2026 year. Some of the 
meetings will be held using 
the Zoom Software and 
some will be in-person at 
the School for Visual Arts 
(SVA)—136 West 21st 
Street, Room 418F. Tickets 
for all events have to be 
purchased in advance on 
Eventbrite. An $8 donation 
is suggested.

Tues.     9/16/25 SVA
Tues. 10/14/25 Zoom
Tues. 11/11/25 Hybrid
Tues. 12/16/25 Zoom *
Tues.   1/20/26 Hybrid
Tues.   2/17/26 Zoom
Tues.   3/17/26 Hybrid
Ties.   4/14/26 Zoom
Tues.   5/19/26 Hybrid
Tues.   6/16/26 Zoom *

SVA = in-person only
Zoom = online only
Hybrid = in-person and online 

* members night

iPhone Photography Conference 
online from KelbyOne

March 9–11, 2026
Preregister for $149

Click Here

Night Photo Summit 

Presented by National Parks at Night, this three-day all-online 
night photography conference features over 40 world-class 
presenters, 50 sessions, image reviews, parties, film screening, 
and more. Oh, and an astronaut! 

Inspiration, education, camaraderie and fun, from the comfort 
of home. This year's event is running February 13th (Friday) - 
15th (Sunday).

For more information, visit the Night Photo Summit website.

https://nationalparksatnight.us12.list-manage.com/track/click?u=77a823aa4cda63437eedd2ee4&id=5b1c7a54c4&e=721fa8234f
https://kelbyonelive.com/?utm_source=ActiveCampaign&utm_medium=email&utm_content=Press%20play%20%20This%20is%20iPhone%20photography&utm_campaign=iPhone%202026%20-%20Beyond%20Scrolling%20-%20Dec%2018%20(Copy)
https://www.eventbrite.com/e/about-ansel-adams-with-dr-caterina-y-pierre-tickets-1000889356007?aff=oddtdtcreator&utm_source=eventbrite&utm_medium=email&utm_campaign=post_publish&utm_content=shortLinkNewEmail
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Small Works is a photography exhibition by women and non-binary artists using cell phones. 
Curated by Claudia Sohrens, Small Works embraces phoneography as an accessible and 
contemporary practice, exploring how everyday acts of seeing can become forms of collective 
storytelling shaped by personal, social, political, and environmental conditions. 

This exhibition also serves as a fundraiser for the PWP 50th Anniversary Documentary—a film 
project dedicated to preserving and amplifying the history, impact, and voices of women in the 
field of photography. 

Selected works will be exhibited at The Breezeway at the Borough of Manhattan Community 
College's Tribeca Performing Arts Center from March 8th–21st.
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Schedule of Activities

Park West Camera Club meets 
just about every Monday night 
(with some exceptions for a 
few holidays and a shortened 
summer schedule).

Due to the coronavirus 
pandemic and its aftermath, 
Club activities will be virtual 
using the Zoom software. 
Members will be emailed all 
the information necessary to 
log in and participate. Guests 
may request log-in details by 
emailing Park West Camera 
Club at <pwccny@gmail.com>

Check the Club’s Website 
<www.parkwestcameraclub.org>  
for late-breaking details on 
PWCC meetings and other 
Club activities. 

All Club meetings begin    
at 6:30 p.m. You may log on 
using the Zoom software 15 
minutes earlier.

Listed on the following 
pages are PWCC activities 
marked with an  asterisk (*). 
Also listed are Photo Ops  
(opportunities to take photos) 
and Photo Events (of interest 
to photographers).

* Monday, February 9th
Before and After

We are always asking other 
photographers, “How did you 
do that?” Tonight we will get 
the answers as Club members 
present their Before and After 
images of the same shot,… and 
explain what they did and why 
they did it. Join us as we learn 
from each other. The entry 
deadline is February 7th.

* Tuesday, February 10
Print Salon

The Club’s Print Salon will be 
meeting this afternoon. See the 
article on page 20 of this issue 
of Photo Notes for detailed info  
on the group and how to get in    
touch with Betsy Currier if 
you’d like to participate.

Tuesday, February 10
NYMACC Meeting

The New York Metro Area 
Camera Council is an umbrella 
organization for camera clubs 
and photographers in the area. 
All Club members are invited 
to attend this meeting to see 
what goes on around town (in 
photography). This meeting 
starts at 7 p.m. If you’d like to 
join the meeting NYMACC at 
<deborah.NYMACC@gmail.com> 
for the Zoom link. 

Monday, February 16
Photo Op—

Presidents’ Day
The birthday of U.S. President 
George Washington (February 
22nd) was first celebrated as a 
federal holiday in the United 
States in the 1880s. In 1968 the 
holiday was adapted to honor 
the birth of President Abraham 
Lincoln (February 12th); it was 
moved to the third Monday in 
February; and it was renamed 
Presidents’ Day. Here are a few 
things you might want to 
check out as photo ops: visit 
the Intrepid Sea, Air & Space 
Museum Complex; take a ferry
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mailto:pwccny@gmail.com
http://www.parkwestcameraclub.org
mailto:deborah.NYMACC@gmail.com
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ride to Ellis Island and the 
Statue of Liberty; take out a 
loan for a helicopter tour of the 
Big Apple; circumnavigate the 
City with the Circle Line; and 
so it goes.

* Monday, February 16
Guest Speaker

Tonight’s guest photographer 
is Antonio Rosario. He is a  
Nebraska-based (formerly 
from Brooklyn) commercial, 
fine art, and street photogra-
pher known for capturing 
everyday moments, teaching 
photography, and co-hosting 
the Street Shots podcast. He's    
a School of Visual Arts alum 
with extensive experience as a 
photo editor, instructor, and 
filmmaker. Check Antonio’s 
website <www.amrosario.com> 
to see more of his images. 

Tuesday, February 17
Photo Op

Lunar New Year
The year of the Fire Horse is a 
two-week long event held in 
Manhattan’s Chinatown every 
year. Today is the Firecracker 
Ceremony (celebrating the new 
moon). It’s being held at Sara 
Roosevelt Park (between 
Chrystie and Forsyth Streets 
from East Houston south to 
Delancey Street beginning at   
11 a.m. (Be sure to check on 
dates, times, and locations    
before you go, there are often 
last minute changes.) 

Tuesday, February 17
Photo Event

Sierra Photo Meeting
The New York City Sierra 
Club’s photography group will 
be holding its meeting tonight. 
The presenter is Lori Lankford. 
Her photography focuses on 
her love of flowers and her 
English Garden. Lori picked 
up her first digital camera 20 
years ago and has not put it 
down since. As a self-taught 
photographer, she loves to 
share her knowledge through 
workshops and lectures. Learn 
more about Lori at her website 
<www.lorilankford.com> This 
is a Zoom-only meeting. All 
tickets must be purchased on-
line at <www.eventbrite.com> 
prior to tonight’s meeting. An 
$8 donation is suggested.
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Red Hook Truck 
© Antonio M. Rosario

Garden Abstract 
© Lori Lankford

http://www.amrosario.com
http://www.lorilankford.com
http://www.eventbrite.com
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* Saturday, February 21
Entry Deadline
Interpretations

The Club will provide every 
member with base images, all 
minimalist in nature. Park 
West members will then alter 
them in any way they see fit—
change things, add things, let 
your skills and software run 
wild. Please stick with only 
traditional camera and post-
processing techniques—this 
means no AI generated image 
enhancements. Have fun.! We’ll 
share all the images at the 
meeting on Monday, February 
23rd. You may work on any or 
all of the base images. Send 
your files to this email only 
<pwccny@gmail.com> by 
11p.m. tonight.

* Monday, February 23
Interpretations 

Tonight we’ll share the images 
that members have altered 
from the original “base 
images.” See the February 21st  
entry, above, for the rules of 
entry. This should be another 
great evening of Park West 
members sharing photos!

* Monday, February 23
Image Deadline

March Competition
Please note that PDI entries  
are due by midnight tonight 
for next week’s competition. 
See page 7 of this issue of Photo 
Notes on how to prepare your 
images. More information is 
available in our Competition 
Manual. Send your images to 
<pwcccompetition@yahoo.com> 
If you want confirmation that 
both of your images were     
received, add this address    
<hfklein@mindspring.com> to 
your email with the images.

* Wednesday, February 26
PDI Workshop Deadline

The deadline for submitting 
images for this Thursday’s  
PDI (projected digital image) 
workshop is tonight at 11 p.m. 
Members may submit one or 
two images for a critique and 
suggestions for improvement. 
See page 7 of this issue of Photo 
Notes for sizing and labeling 
directions. Some images will 
be worked on with a variety   
of photo processing software. 

Only images from the first 10 
members to send them in will 
be reviewed at this workshop. 
Other Club members may join 
the workshop to view and 
comment on the images and 
demonstrations. Send your  
images only to this address 
<pwccny@gmail.com>

* Thursday, February 27
PDI Workshop

This Zoom meeting will begin 
at 7 p.m. The link for this 
monthly workshop will be  
sent to the membership in the 
Club’s Weekly Reminder on the 
previous Friday.

Sunday, March 1
Photo Op

Lunar New Year
The year of the Fire Horse is a 
two-week long event held 
every year. Today is the Lunar 
New Year Parade. It starts 
starts around Mott and Canal 
Streets at 1 p.m. and winds its 
way through. Chinatown to 
Sara Roosevelt Park .
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 * Monday, March 2
Monthly Competition #6

Tonight, the sixth competition 
of the year, asks the questions 
Who will win the top honors? 
What will the judge say about 
your images? Will you agree? 
The only way to find the       
answers to these probing 
posers is to enter and join the 
Zoom meeting. Full rules are 
available on the Club website 
and in our Competition Manual. 
PDI entries must be submitted 
by midnight one week prior to 
today (February 23rd). You 
may enter up to two PDIs. 
Tonight’s judge is Chris     
Murray. He presented his  
portfolio to the Club this past 
January. Chris is a pro shooter, 
and photo instructor living in 
the Thousand Islands region of 
Upstate NY. He mostly shoots 
landscapes—woods, lakes, 
mountains, streams and the 
like—near his home. His work 
has  appeared in publications 
including Elements, Popular 
Photography, On Landscape,   
Life in the Finger Lakes, and  

New York State Conservationist. 
Chris leads photo workshops 
through the Adirondack     
Photography Institute and   
independently. Check out 
Chris’ interesting website 
<www.chrismurrayphotography.com> 
for more info and images.

Tuesday, March 3
Photo Op

Lunar New Year
The Lunar New Year winds up 
today (the full moon) with the 
Lantern Festival. It takes place 
in various nighttime locations 
throughout Chinatown.

* Monday, March 9
Workshop Night

Let’s try again! The program 
for tonight will be presented 
by a representative from one  
of the major sellers of photo 
equipment—Lensbaby. They 
are the manufacturers of 
dozens of lenses and other 
photo gear that allow you to  
be “out-of-the-box” creative. 
Tentatively, the speaker will   
be Jamie Konarski Davidson 
who presented her Motion and 
Multiples program to us this 
past December.

* Tuesday, March 10
Print Salon

The Club’s Print Salon will be 
meeting this afternoon. See the 
article on page 20 of this issue 
of Photo Notes for detailed info  
on the group and how to get in    
touch with Betsy Currier if 
you’d like to participate.

Winter’s Design 
© Chris Murray

© Jamie Konarski Davidson

http://www.chrismurrayphotography.com
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Tuesday, March 10
NYMACC Meeting

The New York Metro Area 
Camera Council is an umbrella 
organization for camera clubs 
and other photography groups 
in the metropolitan area. Park 
West is a founding member of 
the council. All Club members 
are invited to attend tonight’s 
meeting to see what’s going on 
around town, photographically 
speaking, of course. Their 
monthly Zoom meeting starts 
at 7 p.m. If you’d like to join 
the meeting contact NYMACC 
<deborah.NYMACC@gmail.com> 
for the Zoom link.

* Monday, March 16
Guest Speaker

Tonight’s guest photographer 
is yet to be confirmed. As soon 
as it is, we’ll announce it at our 
meetings, post it on the Club’s 
website, and publish it in the 
next issue of Photo Notes. The 
curtain raiser for tonight will 
be Club member and Professor 
Emeritus of African, Native 
American, and South Pacific 
Arts, George Corbin.

Tuesday, March 17
Photo Op

St. Patrick’s Day Parade
This marks the 265th year of 
the St. Patrick’s Day Parade in 
the Big Potato. The parade 
kicks off at 11a.m., moving up 
5th Avenue from 44th Street to 
82nd Street. From pipe and 
drum bands to dancers and 
performers in full regalia, more 
than 150,000 people march in 
the parade every year, with 
more than 2 million spectators 
cheering them on. And don’t 
forget to drop into your local 
pub for some boiled corned 
beef and cabbage.

Tuesday, March 17
Photo Event

Sierra Photo Meeting
The New York City Sierra 
Club’s photography group will 
be holding its meeting tonight. 
The presenter is Dr. Kah-Wai 
Lin. He is a landscape, wildlife, 
and travel photographer based 

in New Jersey. His multi-
faceted career has been marked 
by a remarkable journey that 
spans the realms of medicine, 
research, and the captivating 
world of pro photography. 
Learn more about him at his 
website <www.kahwailin.com> 
This is a hybrid meeting—both 
on Zoom andin-person at the 
School of Visual Arts (136 West 
21st Street, Room 418F). All 
tickets must be purchased on-
line at <www.eventbrite.com> 
prior to tonight’s meeting. An 
$8 donation is suggested.

* Saturday, March 21
Image Deadline

Theme Night
Motion & Multiples

Your images for our theme 
night are due tonight by 11:59 
p.m. You may send up to 10 
photos on the theme of motion 
and multiples—the workshop 
presented to us tast December 
by Jamie Konarski Davidson.  
If you don’t remember that 
presentation, you can find the 
recording of it on the website 
<www.parkwestcameraclub.org> 
Email your properly sized and 
labeled submissions as attach-
ments to <pwccny@gmail.com>
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© Kah-Wai Lin

Image Deadline

mailto:deborah.NYMACC@gmail.com
http://www.kahwailin.com
http://www.eventbrite.com
http://www.parkwestcameraclub.org
mailto:pwccny@gmail.com
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* Monday, March 23
Theme Night

Motion & Multiples
Tonight we’ll go over the 
members’ images on the 
themes of motion (from either 
a moving subject or camera) 
and multiples (composited  
images of the same subject). 
Jamie Konarski Davidson has 
been invited to see the results 
of her workshop efforts.

* Wednesday, March 25
PDI Workshop Deadline

The deadline for submitting 
images for this Thursday’s  
PDI (projected digital image) 
workshop is tonight at 11 p.m. 
Members may submit one or 
two images for a critique and 
suggestions for improvement. 
See page 7 of this issue of Photo 
Notes for sizing and labeling 
directions. Some images will 
be worked on with a variety   
of photo processing software. 
Only images from the first 10 
members to send them in will 
be reviewed at this workshop. 

Other Club members may join 
the workshop to view and 
comment on the images and 
demonstrations. Send your  
images only to this website 
<pwccny@gmail.com>

* Thursday, March 26
PDI Workshop

This Zoom meeting will begin 
at 7 p.m. The link for this 
monthly workshop will be  
sent to the membership in the 
Club’s Weekly Reminder on the 
previous Friday.

* Monday, March 30
Business Meeting #3

Tonight is the third business 
meeting of the 2025-26 Club 
year. There’s always plenty of 
excitement in the air. We will 
continue with any old business 
left over from November’s  

meeting and we’ll move for-
ward with any new business 
both from the chair and from 
the floor.

* 

Monday, March 30
Image Deadline

April Competition
Please note that PDI entries are 
due by midnight tonight for 
next week’s competition. This 
is a themed competition! Both 
of your images must be on the 
theme of Portals. A portal is a 
doorway, a gateway, an en-
trance, or a window (often 
large and imposing) that con-
nects two separate locations. 
See page 7 of this issue of Photo 
Notes on how to prepare your 
images. More information is 
available in our Competition 
Manual. Send your images to 
<pwcccompetition@yahoo.com> 
If you want confirmation that 
both of your images were     
received, add this address 
<hfklein@mindspring.com> to 
your email with the images.
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Photo Quotes 

If the photographer is interested in the people in front of his lens, 
and if he is compassionate, it’s already a lot. The instrument is not 
the camera but the photographer. ~ Eve Arnold

Taking pictures is savoring life intensely, every one hundredth of   
a second. ~ Marc Riboud

mailto:pwccny@gmail.com
mailto:pwcccompetition@yahoo.com
mailto:hfklein@mindspring.com


     February 2026 www.parkwestcameraclub.org 65

SC
H

ED
U

LE
 O

F 
AC

TI
VI

TI
ES Table of Contents 

Club News 
  2 Who’s Who at PWCC
  3 President’s Message
  5 2025-2026 Schedule
  6 Official Club Field Trips
  6 Portfolios Wanted
  6 Member Bios
  6 Avoid These Mistakes
  7 Zooming
  7 Pop-Up Trips
  7 Submitting Images
  7 Emailing PWCC
  8 Sunshine Fund
  8 Mistake to Avoid
  8 Club Meeting Times
  8 PWCC Image Deadlines
  9 Club Participation Nites
  9 PDI Workshops
10 Images of the Month
10 Cumulative Point Totals
11 Winning Images
18 Our January Judge
19 Y•E•P!
20 Print Salon
20 Soho Photo Thank You
20 Smartphone Metadata
21 Curtain Raisers
21 February Birthdays
21 Committee Liaisons
21 Photo Notes Deadlines
22 PSA Membership
22 Instagram
22 On the Website
22 Mistake to Avoid
23 Gallery News & Thoughts
23 Prison Photos
24 You Be the Judge 11
30 Reflections
31 PDI Workshop
33 Smartphone Zooming
34 Essential P-P Steps
34 East Ayrshire Life
35 Confluence/Convergence
35 Keyboard Shortcuts
36 PDI Workshop 2
38 B&H Trade-In
40 About (Y)our Website
40 Mistake to Avoid

Photography News 
41 Express It!
41 Metadata for Film???
42 Perpetual Megapixels
43 Apple Creator Studio
44 Creative Snow Tips
44 Mistake to Avoid
45 Digitizing Old Photos
45 NIK Collection 8
46 Smartphone Zooming
46 Mistake to Avoid
47 Where to Go
48 Composition Techniques
49 Photo Shorts
49 Mistake to Avoid
50 Using Your Camera
51 Photo Shopping
51 Mistake to Avoid
52 PhotoShopping

Exhibits, Workshops, Etc. 
53 B&H Event Space
53 More Keyboard Shortcuts
54 New Life Photos
55 National wildlife Photo Contest
55 Foundations Virtual Summit
56 M&M Photo Tours
57 iPhone Photo Conference
57 Night Photo Summit
57 2025-2026 Sierra Photo Meetings
58 NYMACC Field Trip
58 PWP Small Works

Schedule of Activities 
59 Schedule of Activities
64 Photo Quotes
65 Table of Contents


